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Professional Development Plus (PD+) 
Administrator's Guide 
Use this guide to understand your Professional Development Plus (PD+) subscription and to 
learn how your district can best take advantage of this powerful learning tool. PD+ courses, 
videos, and training webinars are available to your entire staff. Please review the 
information in this guide to ensure that you get the most from your subscription. 

Subscription Term 
When you have a PD+ subscription, all staff members and teachers in your district have 
unlimited access to: 

• PD+ courses 

• PD+ videos 

• PD+ webinars 

PD+ content covers topics from Initial Product Training (IPT) to advanced subjects. All 
training materials are updated on a regular basis to reflect any product changes.  

PD+ content is purchased in one-year increments. Prior to the expiration date, you will 
receive an invoice for the applicable renewal subscription fees for the next renewal 
subscription term. For more information on Professional Development Plus subscriptions, 
contact your account manager. You can also email pdplus@powerschool.com with any 
questions. 

Professional Development Plus Technical 
Requirements 
The PD+ technical requirements listed in the tables below include both hardware and 
software recommendations for best performance when using PD+ training resources. While 
older client operating systems and browser versions that were once supported may continue 
to operate properly, PowerSchool no longer supports them. First, run questions about your 
operating systems or software browser by your system administrator for troubleshooting. 
Then s/he will determine if you need to consult PowerSchool technical support for 
assistance.  

System Requirements 

Security requirements Enable cookies and JavaScript  

Display resolution A resolution of 1024x768 or higher is 
recommended 

Network and connectivity 1mbps per simultaneous user (for example, 
if you have 100 simultaneous users, then 
100mbps is recommended) 
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Supported Web Browsers and Versions 

Platform OS Version Browser 

Windows 8, 8.1 Chrome – 2 latest versions 

Firefox – 2 latest versions 

10 Edge – 2 latest versions 

Chrome – 2 latest versions 

Firefox – 2 latest versions 

Mac OS macOS Sierra+ Safari – 2 latest versions 

Chrome – 2 latest versions 

Firefox – 2 latest versions 

Chrome OS  Chrome – 2 latest versions 

iOS iOS10+ Safari 

Android 7.x+ Chrome 

JAWS Screen Reader* Windows 10 IE – latest version 

VoiceOver Screen Reader* macOS Sierra+ Safari – latest version 

*All features may not be fully supported. 

Creating Campus User Accounts 
As a user with the "Team Leader/Team Admin" access level, you have two options when 
creating user accounts in Campus—create users manually or import them. The method you 
choose depends on the number of accounts you must create to accommodate the size of 
your school or district. Keep in mind that when you import users, you can import only 5,000 
users at a time. 

Method 1 – Add a User Manually 
1. Navigate to the Customer Education Campus at 

https://training.powerschool.com and then sign in by entering your username 
and password and clicking Login  
 
Technical contacts are administrators for their own teams in Campus. Administrators 
work in Campus as either admins or learners. When administrators sign in, they see 
their team Dashboard in the admin view by default. 

2. From the Dashboard, click People in the navigation menu 

3. Click Add a new person 

4. Complete the required First Name, Last Name, and Username fields (indicated with 
an asterisk) 
 
It is recommended that you use the person's email address as their username. 

5. Verify that Send an email to this person with a link to login is checked 
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6. Use the default value of Learner for the users' access level 
 
Choose Team Leader/Team Admin only if the user is another technical contact or 
an administrator who will be assigning courses to learners. 

7. In the Email field, enter the user's email address so that he/she can receive Campus 
notification emails 

8. If you chose to have Campus email the user a login link as noted in step 5, leave the 
Password field blank 
 
Users who receive an email with a link to log in will be prompted to create their own 
passwords after clicking the login link. If you deselected the option in step 5, enter a 
password here and share it with that user. 

9. In the Primary Role field, enter the user's role to make reporting and assigning 
courses easier—enter one of the following roles exactly as it's written here: 
 
Accounting/Finance 
Counselor 
Curriculum Director 
Health Office Staff 
Human Resources 
Office/Administrative Staff 
School/District Administrator 
Teacher 
Technical Staff 

10. Use the default values for the remaining fields 
 
The user will be able to add the remaining demographics when he/she updates 
his/her profile. 

11. To save the new user, click Add person 
 
Or, click Add person and then add another and repeat the steps to add another 
staff/faculty member as a Campus user. 

Method 2 – Import Users 
To import up to 5,000 users at a time, use the "Import people in bulk" feature. 

1. Sign in to the Customer Education Campus by entering your username and password 
and clicking Login at https://training.powerschool.com 

2. Click People 

3. Open the Options menu and select Import people in bulk 

4. On the "Import new people" page, download the import template by clicking use 
this template to get started 

5. Prepare the import file by including the following information for each user: 

• Username* (the user's email address) 

• Email 
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• First Name* 

• Last Name* 

• Team Code* (enter the code in the Team 1 column) 
 
To locate your team code, click Teams. Select your team name 
(school/district name). Click Settings. Locate the "Team code for importing 
people in bulk" area and copy the code. 

• Access Level 
 
Including the access level is optional. Users are imported with the Learner 
access level by default. Include the access level Team Leader/Team Admin 
only if you are importing another technical contact user or an administrator 
who will be assigning courses to district staff members. 

• Job Role 
 
For each user, enter their primary role using one of the following roles, 
exactly as it's written here: Accounting/Finance, Counselor, Curriculum 
Director, Health Office Staff, Human Resources, Office/Administrative Staff, 
School/District Administrator, Teacher, or Technical Staff. Including users' 
roles will make reporting and assigning courses easier. 

*Fields with an asterisk are required. 

6. In Campus on the "Import new people" page, click Choose File or Browse and 
select the CSV file you created 
 

  
7. If your import file contains column headers in the first row, check The first row of 

my file contains column titles 

8. Click Next 

9. Click Map Fields 

10. Select the fields you want to import by using the menus to match the Campus fields 
with the columns in your import file 
 
The values in the menus are from the first row of your import file. 

11. At the bottom of the page, check Send login emails to ensure that the new users 
receive an account activation email 
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12. Click Import 
 
Monitor the progress of the import in the "Recent imports" area of the People page. 
Refresh the page, if needed. 

13. Review the list of users on the People page to ensure that all of the users were 
imported correctly 
 
Note: You cannot import user accounts with email addresses that do not match your 
account’s valid email domain(s). If you import a user who already has a Campus 
account for your school or district, as long as the username is the same, the rest of 
the information in the existing record will be updated. 

Access to PD+ is initiated during a daily batch process. Please wait 24 to 48 business hours 
for access to be granted. If users don't have access after 48 hours, please email 
pdplus@powerschool.com. 

Activating User Accounts 
Once a new user account is created, the new user receives a confirmation email with 
instructions on how to activate his or her Campus account. The new user will click the 
account-activation URL included in the email and will then be prompted to create a new 
account password. 

• Your district’s technical contacts can monitor all of the accounts associated with your 
organization. To view the list of your organization’s Campus users, from the Campus 
Dashboard tab, click People. On the People page, view the information in the Last 
Login column to see which users have never logged in and activated their accounts. 

Resetting User Passwords 
Users can reset their own passwords by clicking I've forgotten my username/password 
on the Campus login page. However, technical contacts can also reset a user's password by 
navigating to the People page in Campus and clicking the user's name. On the user's page, 
open the Options menu and select Reset Password. Then enter and confirm the new 
password and click Save. It is recommended that you enter a temporary password like 
ChangeMe01! since the user will be prompted to create a new password when he/she first 
signs in.  

Share the temporary password with the user. Once the user signs in, he/she will be 
prompted to create a new password. 

Promoting a User to a Team Leader/Team Admin 
In Campus, the users who are technical contacts for their schools or districts should be 
given the "Team Leader/Team Admin" access level. You may also want to make an 
administrator who will be assigning Campus courses to district staff members a team 
leader/admin. To promote an existing learner user to a team leader/admin user, first 
navigate to the People page. Click the user's name. From the Options menu, select View 
[username]. In the Basic Information section, click the Edit icon next to Access Level. 
Open the Access Level menu and select Team Leader/Team Admin. 
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Using PD+  
After you add Campus accounts for your users, and those users confirm their accounts, they 
are ready to begin training. Encourage your staff to explore the PD+ courses and videos 
available on the Customer Education Campus. Staff members who wish to attend a webinar 
should visit PowerSource to sign up for one. 

Accessing PD+ Training 
PD+ training videos and courses cover a wide range of products and their related topics in a 
variety of formats. Use the filters in the Content Library to search the library by role-based 
learning paths, products, topics, and more.  

To access a PD+ course: 

1. To sign in to the Campus, enter your username and password and click Login at 
https://training.powerschool.com 

2. Click Content Library > PD+ 

3. Use the Topics filters to choose a course that you want to view, such as searching by 
the product and topic 

4. Once you find a course or video, click the title 

To resume a course or video: 

1. To sign in to the Campus, click Login at https://training.powerschool.com 

2. On the Home page, view the course or video Under My Courses or click In Progress 
to access your class list 

3. Locate the course or video you wish to complete and click the title 

Attending a Webinar 
PD+ webinars have not yet been added to the Customer Education Campus. You must sign 
in to PowerSource to view available training webinars. 

To attend a training webinar: 

1. Sign in to PowerSource by entering your username and password and clicking Login 
at https://support.powerschool.com 

2. Click Training > Training Calendar 

3. Select a training webinar and click Request 

4. Verify the registrant's information is correct and click I have read and agree to 
the Terms of Registration 

5. Click Submit 

Enrolling Your Staff in PD+ Training 
Technical contacts with a Campus role set to "Team Leader/Team Admin" can enroll users in 
PD+ training. Technical contacts can give other administrators in their district permission to 
assign PD+ training by assigning them the Team Leader/Team Admin access level. 
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Your district’s technical contacts can monitor all of the accounts associated with your 
organization. To view the list of your organization’s Campus users, from the Campus 
Dashboard tab, click People. On the People page, view the information in the Last Login 
column to see which users have never logged in and activated their accounts. 

To assign training: 

1. From the Campus Dashboard, click Teams 

2. Click the name of your team (school/district name) 

3. Click Courses 

4. Click Assign Courses to [your team name] 

5. Check the boxes next to the names of the videos, courses, and/or learning paths you 
want to assign to your team and then click Assign 
 
The assigned videos and/or courses will now appear in each user's My Courses list on 
their Campus Home page. 

To assign training to an individual user: 

1. From the Campus Dashboard, click People 

2. Click the name of the person you wish to assign a course 

3. Click Courses 

4. Click Assign to Course 

Reporting Options 
Technical contacts with a Campus role set to "Team Leader/Team Admin" can view and run 
reports to track PD+ course and PD+ video usage.  

Campus Dashboard 
Technical contacts sign in to their Campus Dashboards in the admin view by default. At the 
top of your Dashboard, view the following metrics. Click each metric to reveal more details. 

• Total Courses – The total number of courses that are assigned to or have been 
completed by users in your school or district 

• Total Users – The total number of users in your school or district who have Campus 
accounts 

• Active Courses – The total number of courses that are assigned to or have been 
completed by users in your school or district in the last 30 days 

• Active Users – The total number of users in your school or district who have logged 
in to Campus in the last 30 days 

Also on the Dashboard, in the Team Reports area, access the Course Activity, User Activity, 
and Module Activity quick reports for your school or district. 
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Campus Reports 
Navigate to the Reports page to view additional metrics about the users in your school or 
district, to run quick reports, to run usage reports, or to create your own reports. 

From the Campus Dashboard, click Reports. In the "Quick reports" or "Usage reports" 
areas, click a report name to run the report.  

Filter the quick report results by clicking the filter menu (looks like three horizontal lines), 
selecting which fields you want to include, and clicking Run Report. 

Some of the reports you can run include: 

• Learning Paths – View the total number of learning paths assigned to or completed 
by users in your school or district 

• Courses – View the total number of courses assigned to or completed by users in 
your school or district 

• People – View all of the users in your school or district who have Campus accounts, 
along with the total number of courses they are taking or have taken, and their 
completion rates 

• Achievements – View the total number of achievements (people who have earned 
completion certificates) by course 

To export the results of a quick or usage report: 

1. Click Reports 

2. Click the name of a quick or usage report to run the report 

3. Click Download/Schedule this report 

4. Enter a report title 

5. Open the Options menu and choose Download or Schedule 
 
If you choose Schedule to set up a one-time or recurring report, enter the email 
address of the person to which the report will be sent, along with the frequency. 

6. Open the Format menu and choose CSV or PDF 

7. Click Run 
 
The report will be emailed to you or to the specified recipient. 

To create a custom report: 

1. Click Reports 

2. On the Reports page, click Reporting Engine 

3. Then click Team > Details > Results 

4. Choose to build a report on a learning path or course 

5. Select the content you want to report on by selecting from the list of fields or 
removing existing fields 

6. Click Next 

7. Using the filter options, choose the scope of the data to include in the report 
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8. Click Next 

9. Preview your report and click Next to continue 
 
If you need to make edits, click Previous to return to the previous screens. 

10. Enter a report name 

11. To schedule this report, change the default frequency setting to your preferred 
frequency and click Build & Save 
 
To save this report to your dashboard, use the default frequency setting of Run 
once now and click Build & Save. 

12. To download the report once, click the Download Now tab and then click Download  

13. Once the report is ready, click the Download icon to save it  

PowerSchool Professional Development Plus (PD+) Certificate 
When a user completes a video of any length or the final quiz in a PD+ interactive course 
with a score of 60% or higher, a certificate of completion is generated. 

To print your certificate: 

1. Sign in to the Customer Education Campus by entering your username and password 
and clicking Login at https://training.powerschool.com 

2. Click Achievements 

3. Use the "Search for an achievement" field to find the particular course you are 
looking for 
 
Note that only completed courses and videos will have a certificate of completion. 
The certificates will contain the title of the course or video, the date of completion, 
as well as the user's name and a certifying signature. 

4. Click Download certificate and print the certificate for your records 

Having problems finding your certificate?  
PD+ video and course completion certificates can be downloaded from the Achievements 
page. If you can't find the certificate, verify that you passed the final quiz, that you are 
meeting the system requirements as specified in the PD+ Technical Requirements section, 
and that you are not experiencing browser caching problems.  

Clearing the browser cache varies from browser to browser, so perform an Internet search 
to learn how to clear your browser cache. 
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Job Roles and Recommended Courses 
Use the next section as a guide to determine which PowerSchool SIS or Unified Classroom 
courses your faculty and staff should take based on their job roles. Taking additional 
courses may be recommended to meet variations in role responsibilities.  

Use the Learning Paths filter in Campus to locate these learning paths, as well as 
recommended courses for additional roles and products. 

PowerSchool SIS Administrators (District Technology 
Staff) 
Campus role: Technical Staff 

Required: 

1. PowerSchool SIS: Basics for Admin Users (Part 1, Part 2, Part 3) 

2. PowerSchool SIS: Administration and Management 

3. PowerSchool SIS: Security (Part 1, Part 2) 

4. PowerSchool SIS: Setting Up District Grading Preferences 

5. PowerSchool SIS: Setting Up School Grading Preferences 

To understand the basic functionality of the system from the end user’s point of view, 
PowerSchool SIS administrators should take the following courses: 

1. PowerSchool SIS: Data Manager 

2. PowerSchool SIS: Managing Staff in PowerSchool 

3. PowerSchool SIS: Managing Student Behavior and Discipline in PowerSchool 

4. PowerSchool SIS: Administration and Management 

5. PowerSchool SIS: Communication Tools (Part 1, Part 2) 

6. PowerSchool SIS Management Cycle 

7. PowerTeacher Pro courses 

• PowerTeacher Pro Part 1: Setup, Assignments, and Grading 

• PowerTeacher Pro Part 2: Analysis and Reporting 

To prepare to set up the PowerSchool SIS Student and Parent Portals and PowerSchool 
Mobile, PowerSchool SIS administrators should take the following courses: 

1. PowerSchool SIS: Student and Parent Portals 

2. PowerSchool SIS: Setting Up Student and Parent Access 

Before the end of the first term or grading period at any schools in the district, the 
PowerSchool SIS administrator should take the following courses: 

1. PowerSchool SIS: End of Term Part 1 – Verifying Grades 

2. PowerSchool SIS: End of Term Part 2 – Storing Grades 

3. PowerSchool SIS: End of Term Part 3 – Reporting Grades 
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Depending on the types of schools in the district—secondary, elementary, or both—
PowerSchool SIS administrators should take one or both of the following: 

1. PowerSchool SIS: During the School Year Scheduling – Secondary  

2. PowerSchool SIS: During the School Year Scheduling – Elementary  

To prepare for the beginning of a new school year, PowerSchool SIS administrators should 
take the following courses: 

1. PowerSchool SIS: Start of Year Part 1 – District and School Administration 

2. PowerSchool SIS: Start of Year Part 2 – Scheduling and Attendance 

3. PowerSchool SIS: Start of Year Part 3 – Grading, Assessment, and Reports 

4. PowerSchool SIS: Start of Year Part 4 – Student Information and Parent Access 

Additional Recommended Training: 

1. PowerSchool SIS: Attendance Tracking and Notification 

2. PowerSchool SIS: Automated Walk-In Scheduler 

3. PowerSchool SIS: Counselor and Administrative Skills 

4. PowerSchool SIS: High School Counselor and Administrative Skills 

5. PowerSchool SIS: Enterprise Reporting for Report Users (Part 1, Part 2) 

6. PowerScheduler: Prepare to Build (Part 1, Part 2, Part 3, Part 4, Part 5, Part 6) 

7. PowerScheduler: The Load Process (Part 1, Part 2, Part 3, Part 4, Part 5) 

8. PowerSchool SIS: Setting Up Standards-Based Grading 

9. PowerSchool SIS: Setting Up Health Record Management 

Secondary and Elementary Principals 
Campus role: School/District Administrator 

Required: 

1. PowerSchool SIS: Basics for Admin Users (Part 1, Part 2, Part 3) 

2. PowerSchool SIS: Administration and Management 

3. PowerSchool SIS: Security (Part 1, Part 2) 

4. PowerSchool SIS: Setting Up District Grading Preferences 

5. PowerSchool SIS: Setting Up School Grading Preferences 

To understand the basic functionality of the system from the end user’s point of view, 
principals should take the following courses: 

1. PowerSchool SIS: Enrolling and Transferring Students 

2. PowerSchool SIS: Managing Grades and Academic Data (Part 1, Part 2)  

3. PowerSchool SIS: Managing Staff in PowerSchool 

4. PowerSchool SIS: Managing Students in PowerSchool 

5. PowerSchool SIS: Managing Student Behavior and Discipline in PowerSchool 



Job Roles and Recommended Courses 

Copyright © 2020 PowerSchool Group, LLC or its affiliates. All rights reserved. 13 

Return 
to 

Contents 

6. PowerSchool SIS: Communication Tools (Part 1, Part 2) 

7. PowerTeacher Pro (PTP) or Unified Classroom (UC) courses 

• PowerTeacher (PTP or UC) 

• PowerTeacher Pro Part 1: Setup, Assignments, and Grading 

• PowerTeacher Pro Part 2: Analysis and Reporting 

• Unified Classroom: Getting Started 

• Unified Classroom: Grading Setup, Assignments, and Scoring 

• Unified Classroom: Analyzing Student and Class Progress 

• Unified Classroom: Using Grading Reports 

8. PowerSchool SIS: Counselor and Administrative Skills 

9. PowerSchool SIS: High School Counselor and Administrative Skills 

10. PowerSchool SIS: Enterprise Reporting for Report Users (Part 1, Part 2) 

To prepare to set up the PowerSchool SIS Student and Parent Portals and PowerSchool 
Mobile, principals should take the following courses: 

1. PowerSchool SIS: Student and Parent Portals 

2. PowerSchool SIS: Setting Up Student and Parent Access 

Before the end of the first term or grading period at any schools in the district, principals 
should take the following courses: 

1. PowerSchool SIS: End of Term Part 1 – Verifying Grades 

2. PowerSchool SIS: End of Term Part 2 – Storing Grades 

3. PowerSchool SIS: End of Term Part 3 – Reporting Grades 

Depending on the methods used to record attendance in the district—meeting, daily, or 
both—principals should take the following courses: 

1. PowerSchool SIS: Managing Meeting Attendance 

2. PowerSchool SIS: Managing Daily Attendance 

3. PowerSchool SIS: Attendance Reports 

Depending on the types of schools in the district—secondary, elementary, or both—
principals should take one or both of the following: 

1. PowerSchool SIS: During the School Year Scheduling – Secondary  

2. PowerSchool SIS: During the School Year Scheduling – Elementary  

To prepare for the beginning of a new school year, principals should take the following 
courses: 

1. PowerSchool SIS: Start of Year Part 1 – District and School Administration 

2. PowerSchool SIS: Start of Year Part 2 – Scheduling and Attendance 

3. PowerSchool SIS: Start of Year Part 3 – Grading, Assessment, and Reports 

4. PowerSchool SIS: Start of Year Part 4 – Student Information and Parent Access 

Additional Recommended Training: 
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1. PowerSchool SIS: Attendance Tracking and Notification 

2. PowerSchool SIS: Automated Walk-In Scheduler 

3. PowerSchool SIS: Data Manager 

4. PowerScheduler: Prepare to Build (Part 1, Part 2, Part 3, Part 4, Part 5, Part 6) 

5. PowerScheduler: The Load Process (Part 1, Part 2, Part 3, Part 4, Part 5) 

6. PowerSchool SIS: Administration and Management 

7. PowerSchool SIS: Setting Up Standards-Based Grading 

8. PowerSchool SIS: Setting Up Health Record Management 

Office and Administrative Staff 
Campus role: Office/Administrative Staff 

Required: 

1. PowerSchool SIS: Basics for Admin Users (Part 1, Part 2, Part 3) 

2. PowerSchool SIS: During the School Year Scheduling – Secondary  

3. PowerSchool SIS: During the School Year Scheduling – Elementary  

4. PowerSchool SIS: Enrolling and Transferring Students 

5. PowerSchool SIS: Managing Staff in PowerSchool 

6. PowerSchool SIS: Managing Students in PowerSchool 

7. PowerSchool SIS: Managing Student Behavior and Discipline in PowerSchool 

8. PowerSchool SIS: Communication Tools (Part 1, Part 2) 

Before the end of the first term or grading period at each school, office staff should take the 
following courses: 

1. PowerSchool SIS: End of Term Part 1 – Verifying Grades 

2. PowerSchool SIS: End of Term Part 2 – Storing Grades 

3. PowerSchool SIS: End of Term Part 3 – Reporting Grades 

Depending on the methods used to record attendance at each school—meeting, daily, or 
both—office staff should take the following courses: 

1. PowerSchool SIS: Managing Meeting Attendance 

2. PowerSchool SIS: Managing Daily Attendance 

3. PowerSchool SIS: Attendance Reports 

Recommended: 

1. PowerSchool SIS: Attendance Tracking and Notification 

2. PowerSchool SIS: Automated Walk-In Scheduler 

3. PowerSchool SIS: Data Manager 

4. PowerSchool SIS: Enterprise Reporting for Report Users (Part 1, Part 2) 

5. PowerSchool SIS: Administration and Management 
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6. PowerSchool SIS: Setting Up District Grading Preferences  

7. PowerSchool SIS: Setting Up School Grading Preferences 

8. PowerSchool SIS: Student and Parent Portals 

Counselors 
Campus role: Counselor 

Required: 

1. PowerSchool SIS: Basics for Admin Users (Part 1, Part 2, Part 3) 

2. PowerSchool SIS: Counselor and Administrative Skills 

3. PowerSchool SIS: During the School Year Scheduling – Secondary 

4. PowerSchool SIS: During the School Year Scheduling - Elementary 

5. PowerSchool SIS: Enrolling and Transferring Students 

6. PowerSchool SIS: High School Counselor and Administrative Skills (secondary 
counselors) 

7. PowerSchool SIS: Managing Grades and Academic Data (Part 1, Part 2) 

8. PowerSchool SIS: Communication Tools (Part 1, Part 2) 

Before the end of the first term or grading period at each school, counselors should take the 
following courses: 

1. PowerSchool SIS: End of Term Part 1 – Verifying Grades 

2. PowerSchool SIS: End of Term Part 2 – Storing Grades 

3. PowerSchool SIS: End of Term Part 3 – Reporting Grades 

Recommended: 

1. PowerSchool SIS: Automated Walk-In Scheduler 

2. PowerSchool SIS: Data Manager 

3. PowerSchool SIS: Enterprise Reporting for Report Users (Part 1, Part 2) 

4. PowerSchool SIS: Student and Parent Portals 

5. PowerScheduler: Prepare to Build (Part 1, Part 2, Part 3, Part 4, Part 5, Part 6) 

6. PowerScheduler: The Load Process (Part 1, Part 2, Part 3, Part 4, Part 5) 

Teachers 
Campus role: Teacher 

Select the PowerTeacher Pro (PTP) or Unified Classroom (UC) path. 

Required: 

1. PowerTeacher (PTP and UC) 

2. PowerTeacher: Seating Charts (PTP and UC) 

3. PowerTeacher Pro Part 1: Setup, Assignments, and Grading 
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4. PowerTeacher Pro Part 2: Analysis and Reporting 

5. Unified Classroom: Getting Started 

6. Unified Classroom: Grading Setup, Assignments, and Scoring 

7. Unified Classroom: Analyzing Student and Class Progress 

8. Unified Classroom: Using Grading Reports 

9. Unified Classroom: Grading Reports 

Department Heads and Curriculum Leaders 
Campus role: Curriculum Director 

Required: 

PowerTeacher Pro and Unified Classroom: 

1. PowerSchool SIS: Setting Up School Grading Preferences 

1. PowerSchool SIS: Setting Up Standards-Based Grading 

Recommended: 

PowerTeacher Pro: 

1. PowerTeacher Pro Part 1: Setup, Assignments, and Grading 

2. PowerTeacher Pro Part 2: Analysis and Reporting 

Unified Classroom: 

1. Unified Classroom: Getting Started 

2. Unified Classroom: Grading Setup, Assignments, and Scoring 

3. Unified Classroom: Analyzing Student and Class Progress 

4. Unified Classroom: Using Grading Reports 

Medical Support Staff 
Campus role: Health Office Staff 

Required: 

1. PowerSchool SIS: Basics for Admin Users (Part 1, Part 2, Part 3) 

2. PowerSchool SIS: Setting Up Health Record Management 
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Frequently Asked Questions 
Q: How do I add more than two technical contacts to my district/school? 

A: Ask your PowerSchool account manager about the change in annual fees when you 
increase the number of authorized technical contacts. 

Q: What if I can’t sign in to the Customer Education Campus because I don’t remember my 
username or password?  

A: Most usernames are created using your district/school email address. For passwords, 
click I've forgotten my username/password on the main login page. 

If you continue to have issues, see if the other technical contact for the district/school can 
sign in to the Campus and use the People pages to help you. If not, please contact 
pdplus@powerschool.com.  

 

 

 

 

 


